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Introduction Topics
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1.1. Introduction
Cutting Master 4 is a program that allows you to output directly from your design application to a cutter.
It consists of two parts:
The Cut/Plot plug-in that allows you to set job properties for the cut job from within your design application and
sends the job to Cutting Master 4.
The Cutting Master 4 program that receives the job from the Cut/Plot plug-in and outputs it to the cutter.
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1.2. Software License Agreement
IMPORTANT READ CAREFULLY: This Agreement (as defined below) is a legal contract between You (as defined
below) and SA International Inc. for Flexi, PhotoPrint, EnRoute, or PixelBlaster branded Software (as defined
below).
This Agreement (as defined below) sets forth the terms and conditions for licensing of the Software from SA International Inc. and You (as defined below), and installing and using the Software. This Agreement applies to any
(i) single-user license; (ii) multi-user license; and (iii) original equipment manufacturer (OEM) or Special Edition
(SE) versions of the Software and other branded or customized versions unless otherwise agreed.
BY OPENING THE SEALED PACKAGE CONTAINING THE SOFTWARE OR DOWNLOADING THE SOFTWARE FROM AN
AUTHORIZED ON-LINE SITE, OR OTHERWISE USING THE SOFTWARE, YOU AGREE THAT YOU HAVE READ,
UNDERSTAND, AND AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT AND ANY THIRD PARTY LICENSE
AGREEMENTS REFERRED TO HEREIN, INCLUDING THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY,
JURISDICTION, AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
DO NOT OPEN THE SOFTWARE PACKAGE, INSTALL, OR USE THE SOFTWARE APPLICATION. RETURN THE SOFTWARE
WITH YOUR PURCHASE RECEIPT FOR A FULL REFUND. IF YOU PURCHASED AN AUTHORIZED DOWNLOADABLE
VERSION OF THIS SOFTWARE, TERMINATE THE DOWNLOAD AND YOU WILL NOT BE DEBITED.
DEFINED TERMS
Acts means the Export Administration Act of 1979, as amended, and the Export Administration Regulations
issued thereunder.
Agreement means this End-User License Agreement, including any third-party licenses provided to SA International Inc. for use of the Software.
Intellectual Property Rights means, by way of example, but is not limited to, the following: rights in know-how,
trademarks, copyrights, patents, patent applications (including reissues, renewals, continuations, continuations-in-part, or divisions of any patent or patent application, as appropriate), trade secrets, instructions,
improvements, modifications, suggestions, proposals, programs, ideas, writings, and the like of any sort whatsoever, and any embodiment thereof including, but not limited to, computer programs, documentation,
assembly and detailed drawings, plans, specifications, results of technical investigations and research,
assembly, and parts manuals, artwork, software, programming, applets, scripts, designs, and any other proprietary information of or in connection with the Software.
Information means any type of data You provide to SA International Inc. in any form or manner in connection
with: (i) the purchase of the license to use the Software, (ii) the registration of the license to use the Software; (iii)
in connection with Support Services; or in any other communication between You and SA International Inc.
arising out of the use of the Software whether provided by You or the Software in any media and any form now
known or hereafter existing. By its operation, the Software may provide data to SA International Inc. indicating
the operation of hardware upon which or in connection with the Software may operate and the status, type,
and use made of disposable materials in connection with the operation of the Software. Such data shall be
included in the definition of Information.
In Use means that the Software is loaded onto either temporary (i.e., RAM) or permanent non-portable
memory (e.g., a hard disk, a CD-ROM or other storage device) for that Workstation or other personal computer.
Materials means any applicable, associated documentation for use in connection with the Software as
provided by SA International Inc. in any medium such as, by way of example, printed materials or On-Line.
Network means any electronic system for communicating to more than one PC and where such PCs are physically located in the same premises, except as expressly provided herein.
On-Line means communications by means of the Internet or World Wide Web.
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PC means a personal computer.
Software means, separately or together, the above-identified computer software.
Support Services means any services which SA International Inc. determines to provide in its sole discretion to
maintain the operation of the Software.
You or Your means you, any other entity on whose behalf you are acting, and anyone who you or such entity
authorizes to use the Program.
LICENSE TERMS
The Software is protected by the United States Copyright Law and International Treaties and other Intellectual
Property Rights. The copyrights in the Software should be respected by You just as You would any other copyrighted material, such as a book.
You may make one (1) copy, in machine readable form only, of each registered copy of the Software;
provided that each such copy is used solely for backup purposes (i.e., for the purpose of reinstalling the Software). As an express condition of this Agreement, if You make such a copy, a condition of making that copy is
that You shall reproduce and place on any such copy SA International Inc.'s copyright notice and any proprietary legends as set forth on or in connection with the original copy or as appears or may appear on any OnLine site maintained for that purpose by SA International Inc. The right to make a backup does not extend to
any Materials.
You may transfer Your registered copy of the Software, but only with the assignment of all of Your rights and obligations under this Agreement, to another person or entity and only accompanied by a copy of this Agreement
and only the original Material accompanying the Software. To make this transfer You and the party obtaining
the Software shall each first give SA International Inc. written or On-Line notice of the transfer which must
include that the person or entity has read, understands, agrees, and accepts the terms and conditions of this
Agreement and further provided that You retain no copies of the Software or the Materials.
Except as expressly provided in this Agreement, SA International Inc. does not grant You any rights to patents,
copyrights, trade secrets, trade names, trademarks (whether registered or unregistered), or any other rights,
franchises, or licenses in respect of the Software. You will not adapt or use any trademark or trade name which is
likely to be similar to or confusing with those of SA International Inc. or any of its suppliers or licensors or take any
other action which impairs or reduces the trademark rights of SA International Inc. or its suppliers or licensors.
Single-User License. If you have purchased a single-user license of the Software, you are, by this purchase, granted a limited non-exclusive license to use the Software. If not already installed on a PC you may install the copy
on that one (1) PC. You may access and use the Software on that PC only.
If you are a private business, rather than an individual, authorized personnel associated with the business may
use the Software, but only one (1) person at a time and on that one (1) PC.
For your registered copy of the Software you may make one (1) backup copy which is restricted to your individual use, for backup purposes only, and only for so long as the Software is installed on one (1) PC.
Multi-User License. If you purchased a multi-user license, you are granted a limited non-exclusive license to (i)
use the Software on the number of PCs corresponding to the number licenses purchased (but only one (1) person may use the Software on one (1) licensed PC) and only where all such PCs are owned by you, (ii) make the
Software accessible through the Network so that each licensed PC may use the Software, and (iii) make a
backup copy of the Software for each license you have purchased. You may store, install, and access the
registered network version of the Software via the Network, and only for each licensed PC that will or may
access the Software. For example, if you wish to have five (5) different PCs (counting the server) access the Software on the Network, each PC must have its own paid-up license, regardless of whether or not any of the PCs
use the Software at different times or at the same time.
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You may use On-Line communications to operate the Software subject to the above terms and conditions and
further provided that you own each PC and that each PC has its own paid-up license. For example, if you are
communicating by means of a PC On-Line to another PC, each PC accessing the Software must have its own
paid-up license.
Except as expressly provided herein, it is prohibited to give any copy of the Software to someone who has not
purchased a license from SA International Inc.; to disclose interfaces to the Software, or to duplicate or distribute the Software by any other means including electronic transmission.
UNAUTHORIZED DISTRIBUTION
The Software is protected by copyright and also contains trade secrets owned by SA International Inc. You shall
NOT distribute copies of the Software to others or electronically transfer the Software from one PC to another
over a Network, except as expressly provided in this Agreement. You shall not modify, adapt, transfer, rent,
lease, loan, resell for profit, or distribute the Software, nor shall you decompile, reverse engineer, disassemble
and/or otherwise reduce the Software to a human-perceivable form or create derivative works based upon
the Software or any part thereof.
SUPPORT SERVICES
Use by you of Support Services is governed by SA International Inc.'s policies and programs described in the user
manual, in documentation made available On-Line, and/or in other SA International Inc.-provided materials.
Any supplemental software code provided to you as part of the Support Services shall be considered part of the
Software and subject to the terms and conditions of this Agreement.
INFORMATION
You expressly agree that SA International Inc. may use Information in its business, including for product support
and development. You agree that SA International Inc.'s use of the Information is unrestricted and non-confidential and You automatically grant SA International Inc., its successors and assigns, a non-exclusive, royaltyfree, worldwide, perpetual, irrevocable license in all Intellectual Property Rights in the Information, which
includes the unrestricted right to use the Information in any way SA International Inc. wishes, including, by way
of example and without limitation, to sublicense, copy, transmit, distribute, create derivative works, display and
perform. You expressly waive any claim to a right of publicity or right of privacy or moral rights in such Information.
TERMINATION
Without prejudice to any other rights, SA International Inc. may terminate the Agreement if you fail to comply
with any of its terms and conditions or if you violate SA International Inc. "Acceptable Use Policy" which is posted upon SA International Inc. at www.saintl.biz, or such other internet-accessible location as SA International
Inc. may determine at its discretion. In such event, you shall destroy all copies of the Software (including all of its
component parts) and Materials. SA International Inc. may suspend or deactivate your use of the Software with
or without notice. SA International Inc. reserves the right to discontinue all support for the Software. SA International Inc. will endeavor to notify you of any such discontinuance of such support but assumes no obligation
to do so. From time-to-time SA International Inc. may change the terms and conditions of this Agreement. Your
continued use of the Software indicates your agreement to any such changes.
GOVERNING LAW AND JURISDICTION
The Agreement shall be governed by the laws of the State of Utah and jurisdiction for any dispute, except as
expressly provided herein, shall be exclusively within the courts located within the State of Utah.
ARBITRATION
Any dispute arising directly or indirectly under Agreement may, at SA International Inc.'s sole and exclusive discretion, be submitted to, and settled by arbitration by at least one (1) arbitrator. The arbitration shall be conducted in accordance with the rules for conducting arbitration by an organization previously established for
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conducting arbitration, which arbitration shall take place in Murray, Utah, or such other location in Utah as may
be chosen by SA International Inc. Each arbitrator shall strictly apply Utah law, the Federal Rules of Evidence
and the terms of this Agreement and shall have no power to strike, amend, or modify said terms. Any such proceeding shall, at the exclusive discretion of SA International Inc. be held in confidence by all parties and witnesses. The judgment or the award rendered by the arbitrator(s) may be entered in any court having
jurisdiction thereof and there shall be no trial de novo. At the sole discretion of SA International Inc. the arbitrator(s) may have equitable powers including the right to issue temporary restraining orders and preliminary
injunctions.
PROPRIETARY RIGHTS
All right, title, and interest in and to the Intellectual Property Rights in the Software (including, without limitation,
any images, photographs, animations, video, audio, music, text, and "applets" incorporated into the Software),
the Materials, and any copies of the Software are owned by SA International Inc. except that which is owned
by its suppliers or licensors. Use of any Intellectual Property Rights is restricted to the rights expressly licensed
herein and none other are granted.
DISCLAIMER OF WARRANTY
THE SOFTWARE IS PROVIDED "AS IS." SA INTERNATIONAL INC. AND ITS SUPPLIERS AND ITS LICENSORS DO NOT AND
CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR SUCH FILES.
SA INTERNATIONAL INC. AND ITS SUPPLIERS AND LICENSORS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO
TITLE OR INFRINGEMENT OF THIRD-PARTY RIGHTS, INCLUDING, BUT NOT LIMITED TO RIGHTS IN INTELLECTUAL
PROPERTY RIGHTS, AND MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.
IN NO EVENT SHALL SA INTERNATIONAL INC. OR ITS SUPPLIERS OR LICENSORS BE LIABLE TO YOU FOR LOST DATA,
LOST PROFITS, COST OF COVER OR OTHER ANY CONSEQUENTIAL, INCIDENTAL, OR SPECIAL DAMAGES, EVEN IF A
REPRESENTATIVE OF SA INTERNATIONAL INC. HAS BEEN ADVISED BY YOU OF THE POSSIBILITY OF SUCH DAMAGES
OR FOR ANY CLAIM BY ANY THIRD PARTY.
These limitations apply even if SA International Inc. or an authorized dealer or distributor has been advised by
you of the possibility of such damage. SA International Inc. does not warrant any drivers for plotting, scanning or
other devices. Drivers are provided to you as a service only, and were developed using information provided to
us at the time by equipment manufacturers.
SA International Inc. is not responsible for any typographical errors in the Software or Materials.
SA International Inc. intends to maintain Information in accordance with SA International Inc.'s understanding
of industry practices but assumes no responsibility or liability in connection therewith.
This Agreement sets forth SA International Inc.'s entire liability and your exclusive remedy with respect to the
Software and the use thereof.
This Agreement does not limit any rights that SA International Inc. may have under trade secret, copyright, patent, trademark, or other laws. No representative of SA International Inc. is authorized to make any modification
to this Agreement, or make any additional representations, commitments, or warranties binding upon SA International Inc.
INTEGRATION
This Agreement constitutes the full and complete agreement between the parties with respect to the within
subject matter and supersedes all prior negotiations and agreements (whether written or oral) between the
parties.
DEFINITIONS AND HEADINGS
The definitions provided herein are referred to herein by bold and italicization throughout this Agreement. The
definitions of such terms are understood to be applicable to both singular and plural uses of such defined terms.
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The titles of this Agreement are inserted for convenience only and shall not be construed as limiting in any manner.
AMENDMENTS
No amendment or modification of this Agreement shall be valid or binding unless the same shall be made in writing and signed on behalf of each party.
WAIVER
The failure to enforce any of the terms and conditions of this Agreement by SA International Inc. shall not be
deemed a waiver of any other right or privilege under this Agreement or a waiver of the right to thereafter claim
damages for any deficiencies resulting from any misrepresentation, breach of warranty, or nonfulfillment of any
obligation.
In order for there to be a waiver of any term or condition of this Agreement, such waiver must be in writing and
signed by the party making such waiver.
SEVERABILITY
If any provision of the Agreement is found invalid or unenforceable pursuant to judicial decree or decision, the
remainder of this Agreement shall remain valid and enforceable according to its terms. Without limiting the foregoing, it is expressly understood and agreed that each and every provision of this Agreement that provides for
a limitation of liability, disclaimer of warranties, indemnification or exclusion of damages or other remedies is
intended by the parties to be severable and independent of any other provision and to be enforced as such.
Further, it is expressly understood and agreed that if any remedy hereunder is determined to have failed of its
essential purpose, all limitations of liability and exclusions of damages or other remedies set forth herein shall
remain in effect.
GOVERNMENT REGULATIONS
If you are a U.S. Government end-user, this Agreement conveys only "RESTRICTED RIGHTS," and its use, disclosure,
and duplication are subject to Federal Acquisition Regulations, 52.227-7013(C) (1) (ii).
EXPORT REGULATIONS
Notwithstanding the location of any PC herein, You represent and warrant that, as required by the Acts that,
unless You obtain prior authorization from the United States Office of Export Administration, You will not knowingly re-export, directly or indirectly, nor knowingly allow any other person or entity to re-export, the Software
supplied for any purpose to any of the countries to which such re-exports are prohibited. Your obligation hereunder is subject to the Act, which obligation shall survive the expiration or termination of this Agreement so long
as the relevant Act remains in effect.
ATTORNEY'S FEES
Should SA International Inc. prevail in any lawsuit, action, or proceeding in contract, tort, or otherwise which
arises out of or related to this Agreement, SA International Inc. shall be entitled to recover all of its costs and
expenses including, without limitation, its reasonable attorneys' fees incurred in connection with such lawsuit,
action, or proceeding, including any appeal of such lawsuit, action, or proceeding.
SALES ACROSS INTERNATIONAL BOUNDARIES
As between the parties hereto, and in the sale and delivery of any goods, the United Nations convention
related to the sale of goods shall not apply to any sale of goods deemed to arise under in this or any other agreement between the parties.
© Copyright 2011 by SA International Inc., All rights reserved. No part of this publication may be reproduced,
stored in a retrieval system or transmitted, in any form or by any means, electronic, mechanical, photocopy,
recording or otherwise, without the prior written permission of the publisher. Printed in the United States of
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America. The information in this manual is subject to change without notice and does not represent a commitment on the part of SA International Inc.
The names of actual companies and products mentioned in the Software may be the trademarks of their
respective owners or their subsidiaries or affiliates and may be registered in certain jurisdictions.
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1.3. Supported Applications
On Windows, Cutting Master 4 supports the following design applications:
CorelDRAW X4, X5, X6, X7, X8
Adobe Illustrator CS5, CS6, Creative Cloud
On Macintosh O X, Cutting Master 4 supports the following design applications:
Adobe Illustrator CS5, CS6, Creative Cloud
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1.4. Using the Software
To send a job to a cutter using Cutting Master:
Create the job in the design application.
If desired, add registration marks to your design.
Open the Cut/Plot dialog.
Adjust the job properties in the Cut/Plot dialog.
Send the job to Cutting Master 4.
Use Cutting Master 4 to output the job to the cutter.

CONTENTS │Cutting Master 4 User Guide

CHAPTER
2
Installation and Setup
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2.1. Recommended System Requirements
Before you begin installing the software, read the hardware requirements below. For optimal performance we
suggest that your system meet the recommended requirements. As with all computer software, systems with
faster processors, more RAM, and greater amounts of storage space allow you to work with larger files and keep
your processing time to a minimum.

Processor

Windows

Macintosh

i3 or higher

Intel

RAM

4GB or greater

Installation space
Operating System

1 GB
Windows 7, 8 and 10

Other

OSX 10.7 or greater

Available Port for Output Device
Internet Connection
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2.2. Installing the Software on Windows
2.2.1. Before You Begin
Before you install the software, you should do the following:
Install all of your design applications.
Install any additional drivers that are necessary for your cutters, such as USB drivers.
Set your cutter to operate in GPGL mode. See your cutter documentation for details.

2.2.2. Installation Steps
Full access rights are required to install this software. Be sure to log on to Windows as an administrator account
member.

To install Cutting Master 4:
Uninstall any previous version of the software.
Download and run the Cutting Master 4 installer
Select the Setup language and then click OK.
On the Welcome screen, click Next.
Read and accept the Software License Agreement and click Next.
Choose the Destination Folder the software will be installed into. Click Next.
Select Features and Click Next.
Select the Program Folder where the shortcut for the software will appear. By default, a new folder will be created
for the product.
Click Next to begin installing the software.
If you have Adobe Illustrator installed, you will be prompted for the location of the Plug-ins folder for each version
of Illustrator you have installed.
If necessary, click Browse and select the folder location.
Select Finish.

2.2.3. Steps to uninstall the software
Exit Cutting Master 4 by selecting Exit from File menu.
In the Windows Control Panel, double-click the Add or Remove Programs icon.
Select Cutting Master 4 from the list and click the Change/Remove button.
In the Welcome screen, select Remove and click Next.
Click Yes to uninstall the software.
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2.3. Installing the Software on Mac
2.3.1. Before You Begin
Before you install the software, you should do the following:
Install all of your design applications.
Install any additional drivers that are necessary for your cutters, such as USB drivers.
Set your cutter to operate in GPGL mode. See your cutter documentation for details.

2.3.2. Installation Steps
Full access rights are required to install this software. Be sure to log on to Mac OS X as an administrator
account member.

Follow these steps to install the software:
Download the installer
Double click the Installer icon.
Select a language and then click OK.
Select the product and language to be installed and then click OK.
Read the Software License Agreement and click Accept.
Click Next.
Select the Install Location and click Install.
The software installs. Click Stop to halt installation.
Click Yes to clear the preferences.
Click OK.
Click Quit.

2.3.3. Steps to uninstall the software
Exit Cutting Master 4 by selecting Quit from the application menu.
In the Cutting Master folder, double-click Uninstall.
Click OK.
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2.4. Creating an SAi Cloud Account
The first time you launch Cutting Master 4, the SAi Cloud Connect dialog comes up allowing you to sign in with
an existing account or to sign up to a new account.

If you already have an SAi Cloud account, enter in your email address and password
If you are new to SAi Cloud, Click Need an account? Sign Up
Enter in a valid email address and click Sign Up
Check your email inbox for an email from noreply@saicloud.com
Follow the instructions in the email to create a password
Use the email and password you created to log into SAi Cloud Connect
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3
Creating the Job in the Design
Application
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3.1. Guidelines for Creating Your Design
When creating a job, remember the following guidelines:
Convert all bitmap graphics into vector objects. Cutting Master 4 can only output vector objects.
Objects cannot have patterned fills, bitmap fills, lens effects, gradients, or other custom fill types. Any objects with
these fill types will be ignored by Cutting Master 4, and will not appear in the Cut/Plot dialog.
Use colors or layers to separate objects that you want to output at different times. You can then use the Layering
tab of the Cut/Plot dialog to choose which colors or layers will be output.
There is no need to make duplicate copies of your design in the design application. Cutting Master 4 can easily output duplicates of any design, and can even place multiple copies on the same page.
Don’t worry about objects of the same color that overlap. The Auto-Weld feature can automatically merge overlapping objects together.
If you need to make multiple cutting passes, you can select the number of passes in the Advanced tab of the
Cut/Plot dialog. There is no need to stack up multiple copies of an object to force multiple cutting passes.
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3.2. Accessing the CutPlot Dialog
To access the Cutting Master 4 Cut/Plot dialog:
If you are using Adobe Illustrator, from the File menu, select Cutting Master 4 then Cut/Plot.
If you are using CorelDRAW, select Cut/Plot from the Corel Application Launcher. The Corel Application
Launcher is a list in the standard toolbar that lets you launch other applications from within CorelDRAW.
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3.3. Entering Numerical Values
Cutting Master 4 supports a number of unique features that make it easier to enter numerical values.

3.3.1. Using Built-In Mathematical Operations
The software is able to perform a number of calculations whenever a numerical value is being entered.

3.3.2. Automatic Unit Conversion
If you enter a value using a different unit of measurement than the default unit, the software will automatically
convert the value to the default unit.
For instance, if your default unit is inches, you can enter a value of 1 ft, and the software will convert the measurement to 12 in.
Supported units are:
in, "

inch

ft, '

foot

mm

millimeter

cm

centimeter

m

meter

pt

point

3.3.3. Calculation of Ratios
If you enter a ratio in the format A:B, the software will scale the previous value in the field by the ratio entered.
For instance, if a value is set to 12, and you enter 2:3, the new value will be 8.

3.3.4. Calculation of Percentages
If you enter a percentage in the format X%, the software will scale the previous value in the field by the percentage entered.
For instance, if a value is set to 10, and you enter 90%, the new value will be 9.

3.3.5. Simple Arithmetic Operators
If you enter a simple arithmetic expression, the software will calculate the result of the expression and enter that
value in the field.
The available arithmetic operators, in order of precedence, are:
/

Division

*

Multiplication
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-

Subtraction

+

Addition

For example, if you enter 1/8, the value 0.125 will be calculated.
Operator precedence determines the order in which the arithmetic operations will be calculated when more
than one operation is specified. In the previous list, operators are listed from top to bottom in order of operator
precedence. For instance, if you enter 6/2*3, the software will calculate 6/2 first then multiply the result by 3,
yielding a result of 9.

3.3.6. Automatic Application of Entered Values and Arithmetic
Once you enter a numerical value, ratio, or arithmetic expression in a numerical field, the software will automatically apply that value after a brief delay.
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4
Using CutPlot
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4.1. Sending Jobs to Cutting Master
To send the current job to Cutting Master 4 for output, click the Send button in the Cut/Plot dialog. To exit the
Cut/Plot dialog, click Done.
Once sent to Cutting Master 4, the job will immediately be output, unless the Hold in List option on the General
tab of the Cut/Plot dialog is checked. If Hold in List is checked, the job must be output manually. See “Outputting Jobs from Cutting Master 4” page 19 for details.
Once output, the job will either be deleted, or held in the queue, depending on the After Output setting in the
Advanced tab of the Cut/Plot dialog.
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4.2. Setting Job Properties
The following controls are available on all tabs of the Cut/Plot dialog:
Properties

Click to adjust the setup properties
Click to start Cutting Master 4.
Click to select the Select tool. (This tool is selected by default most of the
time)
Click to select the Zoom tool. Click and drag in the job preview pane to
select an area of the design to zoom in on. For Windows, hold the CTRL
key and click to zoom out. For Macintosh, hold the Option key and click to
zoom out.
Click to select Zoom to Width. The preview pane will automatically zoom in
or out so that the entire width of the media is displayed.
Click to select Zoom to All Objects. The preview window will zoom in or out
so that all of the objects in the design are displayed.

Reset

Click to return job properties to their default settings.

Send

Send the job to Cutting Master 4 with the current settings.

Done

Close the Cut/Plot dialog and return to the design application.

Save to File

Saves the cut job as a file.
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4.3. General Tab Properties
The General tab allows you to specify the size of media, size of the job and the location of your output on the
media.

The following settings are available:
Media Size

The size of the media loaded into your output device. Select from one of the preset
sizes, or specify unique dimensions below.
Poll Size

polls the size of the media loaded in the cutter. This feature only
works if the device and port support bi-directional communications.
The width and height of the media. When a set of unique dimensions is specified, it is automatically added to the list of preset
sizes.

Job Size

Choosing one of these options allows you change the output size and orientation of the
page.
The job's width and height.

CHAPTER 4│Cutting Master 4 User Guide

27

The job's width and height as a percentage of the original.

Position

Fit to Media

Scales the job proportionally so that it is as large as possible
while still fitting within the cuttable area of the output media.

Proportional

When this option is selected, the height and width of the job are
increased or decreased together to keep the original proportions intact.

These settings change the position of the job on the media.
The distance between the job and the right and bottom margins of the cuttable area. You can also change these settings
by dragging the job across the page in the preview pane.
Interactive: moves the cutter as you change the position of the
job on the preview area.
Show me: draws a bounding box of the job without lowering
the tool.
Places the job at the specified distances from the lower and
right edges of the cuttable area of the output media.
Centers the job along the width of the cuttable area.
Centers the job in the middle of the cuttable area. Only available for sheet material.
Rotates the image on the media in 90-degree increments.
Click the button until you achieve the desired orientation.
Flips the selected image on the vertical axis, so that your image
will be mirrored when output.
The number of copies to be output.
The amount of space that will exist between the various tiles and/or copies horizontally.
The amount of space that will exist between the various tiles and/or copies vertically

Selection Only

Output only the selected objects, not the entire design. This option is enabled if you had
objects selected when you opened the dialog.

Repeat Job

Sends the same job again for the number of times specified.

Hold in list

If checked, the job will be held in the Cutting Master 4 queue instead of being automatically output. The job must be output manually from Cutting Master 4.

Use document origin

If not checked, left bottom point of the bounding box of selected objects becomes origin
of plotter. If checked, document origin of Illustrator or CorelDRAW becomes origin of
plotter. Positions of objects from document origin are kept positions from the plotter origin. Note: Document origin of Illustrator or CorelDRAW is the point (0,0) of the ruler.
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4.4. Layer Tab Properties
The layering tab allows you to assign different cutting parameters to different color or layers in your cutting job.
You can cut one color slower than another color, for instance.

The following settings are available:
By color/ By layer

Orders your output by color, or by layer. “Layer” refers to layers in the design application, not overlapping layers of vinyl.
If you choose By color, all objects with the same color will be cut at the
same time, unless Pauses between colors/layers are checked. If you have
overlapping objects of the same color, you will get overlapping contour
cuts.
If you chose By layer, the job will be cut one layer at a time. All objects in
each layer will be cut at once, unless Pauses between colors/layers are
inserted. If you have overlapping objects in a layer, you will get overlapping contour cuts.
There will be no pause between this color or layer and the next
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Output will be paused between this color or layer and the next. This allows you to
load different colored vinyl into your cutter.
Group Layers or colors
by driver options

If selected, the groups or layers with the same conditions will be sent together.

Enable driver options

Check to set the following options in the software. If this option is not checked, the
settings on the output device will be used instead.
Settings can be set individually for each color or layer by selecting the color or layer
in the list then setting the options below (but see Single setting for all).
Single setting for all

If this option is checked, identical driver
options will be used for all colors or layers.

Preset

Driver option presets allow you to save all of
the driver options for a common type of job
and reapply them in a single step.

Condition

The cutter condition number. Numbers
range from 1 to 8. See the documentation
for your cutter for details on which numbers
are valid.

Speed

Speed at which the cutting head or pen
moves across the media. Set to 0 to use the
setting on the cutter.

Force

The amount of downwards force applied to
the cutting head or pen. Set to 0 to use the
setting on the cutter.

Quality

The Quality setting really controls the maximum acceleration of the cutting head or
pen. Lower settings produce higher quality,
at the cost of increased cutting time. Set to 0
to use the setting on the cutter.

Line Type

Select the line type. The following line types
are provided as standard:

You can also edit custom line types with the
Custom Line Editor
Pitch Size

The length it takes for the line pattern to
repeat when a line type other than solid is
selected.

Passes

Defines the number of times that the blade
will cut the same path. Set this option if you
are using thick or hard media that can’t be
cut in a single pass.
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Plotter Controller

If checked, Cutting Master 4 will send the current job to the Graphtec Plotter Controller application for output when the Send button is clicked. This option is only
enabled if the setup is for a device that is supported by the Plotter Controller application. The device setup must use a USB connection. If Plotter Controller is not
installed, this option will be disabled. See the Plotter Controller documentation for
details on outputting jobs from that application. When this option is checked, the following fields in the cut/plot dialog will be disabled:
Job width
Job height
Percent width
Percent height
Fit to media
Proportional
Copies
Copy spacing
Use registration marks
Hold in list
After output
In addition, the Rotation control will be limited to the 0 and 90 degrees counterclockwise settings

CHAPTER 4│Cutting Master 4 User Guide

31

4.5. Editing Custom Line Types
4.5.1. To Add a New Custom Line Type
Select Custom Line Editor from the Line Type list

2. Select one of the 3 custom line types.
Custom 1 : The length of the first segment in the line.
Custom 2 : The length of the space between line segments.
Custom 3 :The length of the second and third line segments, if any. Custom 1 is made up of one repeating
line segment, while Custom 2 has two segments that repeat in a pattern, and Custom 3 has three.
3. Edit the length of the line segments in the corresponding fields
Click Add to Save the new Line type
Enter a Name for the custom line type

Click OK

4.5.2. To Modify an existing Custom Line Type:
Select the Custom Line from the list
Modify the settings for the line type
Click Save

4.5.3. To Remove a Custom Line Type
Select the Custom Line from the list
Click Remove
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Click Yes

4.5.4. To Export a Custom Line Type
Select the Custom Line
Click Export
Browse for a location to save the file
Enter in a File Name
Click Save

4.5.5. To Import a Custom Line Type
Click Import
Browse for the .xml file and click Open

CHAPTER 4│Cutting Master 4 User Guide

33

4.6. Panel Tab Properties
The Panel tab allows you to split a job up into a number of smaller tiles that are then output separately

Panel Size

The panel is the part of the job that will be split up into tiles and output by the software. If the
panel is reduced in size so that it does not cover the entire job, only the parts covered by the
panel will be output.
Shows the width and height of the panel. To adjust, enter a
number or use the arrows.
The size of the margin. The margin is the part of the panel that
extends outside of the boundaries of the job.

Selected Tile

Selects which tile’s width and height are displayed in the fields below.
Selects a tile to be edited. The selected tile is highlighted in the
preview pane.
Shows the width and height of the selected tile. To adjust,
enter a number or use the arrows.
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Output

All Tiles

If checked, the selected tile will be output with the rest of the
job. If cleared, the tile is marked with a mesh overlay in the preview pane, and will not be output.

These settings apply to all tiles and help you quickly set up automatic tiles, of equal size.
Selecting this option divides the job vertically into the number
of columns specified. Each column will be of equal width.
Selecting this option divides the job into the number of rows
specified. All rows will be of equal height.
If you know that you want tiles of a certain size, enter the values for the width and height of the tiles here. All tiles will be
changed to the specified size.

Overlap

Specifies the amount of overlap between rows and columns. By overlapping, you can eliminate any gaps between the tiles when assembling the final output. Overlap is measured as
the total amount two rows or columns overlap.
Check to create an overlap on the vertical edges of tiles.
Check to create an overlap on the top and bottom edges of
tiles.
The width of the overlap. Enter a negative number to create
an offset between tiles.

Interleave Cop- In case of multiple copies of tiled objects, this setting defines how the tiles will be grouped
ies
Interleave

No Interleave
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Sets the primary direction of
the panel mode to vertical.
This allows for the vertical tiles
to be split individually horizontally

Sets the primary direction of
the panel mode to horizontal.
This allows for the tiles to be
split individually vertically.

Sets the panel mode to be
adjusted both horizontally and
vertically.
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Reset

Auto-tile

A tile will automatically be created that includes all selected
objects. If no objects are selected, all of the objects in the
design will be included. If the design is too large to fit on the
selected media, it will automatically be tiled so that each tile is
the maximum possible size. Auto-tile does not attempt to tile
the entire page, just the design or the selected objects.

Tile to Border

The entire design page is automatically tiled. If the page is too
large to fit on the selected media, it will be tiled so that each tile
is the maximum possible size.

Resets all settings to their original state
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4.7. Dividing a Job into Tiles
The job starts as a single large tile that covers the entire job. This tile is selected by default.
To divide the job into multiple tiles, reduce the width and/or height of the first tile using the
and
fields in
the Selected Tile section. New tiles will automatically be created to cover the exposed areas of the job.
For instance, to divide a 30x25 job into two vertical tiles, set the
15x25. A second 15x25 tile will automatically be created.

field to 15, reducing the size of the first tile to

4.7.1. Dividing a Job into Uniform Rows and Columns of Tiles
To divide the job into a specified number of uniform rows and columns of tiles:
Check

or

to tile the job vertically or horizontally.

Enter the number of columns of tiles in the
Enter the number of rows of tiles in the

field.
field.

Set the amount of overlap between the tiles in the

field.

4.7.2. Dividing a Job into Uniform Tiles of a Specified Size
To divide the job into uniform tiles of a specified size:
Check
Set the

and
and

to set all tiles in the job to be of the specified size.
fields to the width and height desired for the tiles.

Set the amount of overlap between the tiles in the
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If the specified tiles do not cover the job evenly, the tiles at the top and right edges will be made small enough to
fit in the gap.
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4.8. Selecting a Tile
To select a tile, either click on the tile in the preview pane, or select the tile using the
Tile section of the Tile tab.
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4.9. Editing Tiles
To edit the size of the selected tile, change the values in the

and

fields.

You can also resize tiles by dragging their edges in the Preview Pane.

If any of the All Tiles checkboxes are checked, the
and
fields may be disabled. In this case, the fields
have been overridden in order to keep all tiles uniform. The tiles will not be editable using the Preview Pane
either.

If you drag the edges of the panel over so that part of the job is exposed, a new tile will be created to cover the
exposed area of the job. The exception to this is if you resize the panel using the cropping handles.
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4.10. Cropping a Job
To crop out part of a job so that it will not be output:
Open the Job Properties dialog for the job.
Select the Tiling Preview view of the job.
Drag the red cropping handles so that the unwanted parts of the job are cropped out.

Cropped-out areas of the job will not be output.
You can also crop a job by reducing the panel size using the
the Tile tab.
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4.11. Advanced Tab Properties
The Advanced tab allows you to set several options specific to cutting jobs.

The following settings are available:
Advance after plot

Advances the media after the job has been output and resets the origin.

Cross cut

If checked, after a job has been cut, the cutter will slice across the output media above the job, separating it from the rest of the media still
in the cutter.
For a multi-page job, the cutter will do a cross-cut after each page in
the job.
This option is only enabled for cutters that support the feature
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Additional advance

Advances the media an additional amount after the job has been output.

Weed Border

Cuts a border with the specified Panel margin around all objects in
the selected color and layer.

The weed border is always a solid line, regardless of any settings in
the Layering tab.
Panel Margin

The panel margin used for the weed border.

Horizontal weed lines

Adds weedlines between lines of text (or objects). Weedlines are
always solid lines, regardless of the line settings in the Layering tab.

Vertical weed lines

Adds weedlines between characters (or objects). Weedlines are
always solid lines, regardless of the line settings in the Layering tab.

Optimize cutting order

Select the order in which objects in the design will be cut:
None

The objects are cut or plot in the
order they were created

Speed Priority

The objects will be cut in an
order that maximizes cutting
speed.

Restrict Media Movement

The objects will be cut in an
order than minimizes the
amount that the media has to
move.

Auto-weld

Removes overlapping areas of objects that have the same color.

Convert strokes to outlines

Selects whether the strokes will be cut separately as an object.

Cut page crossing

When the output is split up over a number of pages, cut page crossing will cut a line between 2 pages

Cut Page Crossing ON

Cut Page Crossing OFF

Units

Specifies the units that will be used for measurements.

After output

Sets what will be done with the file after it is output. Select either
Delete or Hold.

Step size

The number of steps per unit length currently set on your cutter.

Divde

Always cuts segments from the outside in

Cutting Direction

Sets the direction in which objects will be cut
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Reset

Original

Maintains the direction that was
assigned in the design application

Clockwise

Overrides the assigned direction. All objects will be cut
clockwise

Counter Clockwise

Overrides the assigned direction. All objects will be cut
counter clockwise

Restores all settings to their original state
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4.12. Preventing Tiles from Being Output
To disable a tile and prevent it from being output with the rest of the job, do one of the following:
Double-click on the tile in the preview pane.
Right-click on the tile in the preview pane.
Disabled tiles are marked with a hash pattern.

To make a disabled tile able to be output again, double-click or right-click the disabled tile a second time.
One tile in each job must always be enabled. If you try to disable all of the tiles, one of the other tiles will become
enabled again.
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4.13. Registration Marks Tab Properties
The options on this tab are only available if Registration Marks were added to the design first.

The following parameters are available
Use Registration Marks If your design contains registration marks, this option will be enabled by default.
Number of copies horizontally
Number of copies vertically
Spacing in between horizontal copies
Spacing in between vertical copies
Horizontal offset
Vertical offset

CHAPTER 4│Cutting Master 4 User Guide

47

Reverse-side Registration Marks

This option allows you to cut out the registration marks on the printed side so they
can be measured when cutting the back side. This is necessary when cutting a box
for example, where certain paths need to be scored from the back.
Cut Surface
Cut back Side (Low Volume Production)
Cut back Side (High Volume Production)

Return to Scanning
Base Point after Plot

Moves the tool head to the base point after cutting.

Use previous the first Performs a one-point reading on four-point registration marks
registration mark adjusted with Base Point
Use previous 4-point
Registration Mark
adjusted

Four-point registration marks are performed onthe first sheet. In case of cutting multiple copies, only one-point registration marks are performed from the second sheet
onwards.

Cut segment by segment

Cuts all the objects in a segment before proceeding to the next segment.

Reset

Resets all parameters to their defaults
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4.14. Working with Driver Option Presets
Driver option presets allow you to save all of the driver options for a common type of job and reapply them in a
single step.

4.14.1. Creating Presets
To save the current driver options as a new preset:
From the Preset list, select Save as.

Enter a name for the new preset.
Click OK.

4.14.2. Updating Presets
To update the currently selected preset with the currently selected driver options, from the Preset list, select
Save.

4.14.3. Applying a Preset
To apply the driver options saved in a preset to the current job, select the preset from the Preset list.

4.14.4. Renaming a Preset
To rename a preset:
Select the preset you want to rename from the Preset list.
Select the Rename command from the Preset list.
Type in the new name and press OK.

4.14.5. Deleting a Preset
To delete a preset:
Select the preset you want to delete from the Preset list.
Select the Delete command from the Preset list.
Click Yes.
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CHAPTER
5
Outputting Jobs from Cutting
Master
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5.1. Basic Elements of Cutting Master
The following are the basic elements of Cutting Master :

1

Toolbar

2

Device Bar

3

Setup Bar

4

Job Area

5.1.1. Column Headings
Job Name

The file name of the job

Status

The current status of the job.

Copies

The number of copies to be output.

File Type

The type of job.

Color

The color specified for the material. If multiple colors are specified,
this field will read Multiple.
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5.1.2. Toolbar
A toolbar is located at the top of the main window. It contains tools for the most commonly used functions.
The toolbar functions are:
Add Job

Adds a Adjob to the selected output device.

Send Job

Sends the selected job to the output device.

Abort

Stops selected file from being output.

Delete

Deletes the selected job or jobs.

Help

Opens the Online Help
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5.2. Setting Application Preferences
To set application preferences, from the Edit menu select Preferences.

The following settings are available:
Units

The units of measurement displayed

Precision

The degree of precision to use with measurements

Disable submission of job
names and thumbnail
images to the cloud

Job Names and Thumbnails are stored in your SAi
Cloud account so you can access them via tools
such as job reporting in the SAi Mobile App. With
this checkbox you can disable sending those to
your Cloud account
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5.3. Creating an Output Device
The output device setup provides the link between the software and your output device. It contains the following information:
The type of output device being used.
The method used to communicate with the device.

5.3.1. Creating Your First Output Device Setup
When you start the software for the first time, you are prompted to create your first output device setup:

Select the Manufacturer and Model Name of the output device from the list.
Click Next.
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Edit the Setup name of the device.
Assign a unit ID number to your device. If you have more than one cutter of the same model, this will make it easier
to identify which cutter is which.
5. Select the Port the output device uses for communication. If necessary, edit the communications settings for the chosen port.
Click Finish

5.3.2. Editing Output Device Settings
To edit the properties associated with the output device setup, from the Setup menu, select Setup Properties.
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Setup Name

Name of the Setup

Set Unit ID
Update Unit ID

5.3.3. Changing the port of the Setup
To change the port of a Device Setup, do one of the following :
Select Change Device Port from the Setup menu
Click the Arrow down on the left hand side of the device in the device toolbar and click Change Port
Port

Select the port to which the cutter is connected. The port list is limited to the ports that are actually
present on your computer and usable with your output device.
USB

USB drivers are provided with output devices that support them. Please
make sure the proper drivers are installed when using these ports.

TCP/IP

If your cutter is connected via TCP/IP, enter in the IP address of the cutter

COM

Serial communications port. This port is supported by some of the older cutter models.

CHAPTER 5│Cutting Master 4 User Guide

57

CHAPTER 5│Cutting Master 4 User Guide

58

5.4. Outputting a Test Cut Job
The software allows you to output test cutting jobs to appropriate output devices, to make sure everything is
functioning properly.
To output a test cut job, from the Setup menu, select Test Cut.
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5.5. Outputting Jobs
If the Hold in list box in the General tab of the Cut/Plot dialog is not checked, jobs that are sent to Cutting
Master will be output automatically as soon as they are received.
If Hold in list is checked, the job will stay in the queue until you output it manually.

5.5.1. Saving a Job to a File
To save a job to a .PLT file, do one of the following:
Right Click the Job and select Save As
Select the job and choose Save As from the File Menu
Change the Port of the device to File. With this option, all jobs sent to the device will be saved to a file instead of
being output.

5.5.2. Loading a Saved Job from a File
To load a previously-saved job from a file:
From the File menu, select Add Job.
Select the .plt file to be added.
If you want to copy the file to the local job folder, check Copy to job folder.
Click Add

5.5.3. Sending Jobs to the Cutter
To send a job to the cutter, do one of the following:
Select the job and from the File menu, select Send.
Select the job, then click on the Send button in the toolbar.
Right-click the job and select Send from the context menu.

5.5.4. Aborting the Processing of a Job
To abort the processing of a job while it is being cut, do one of the following:
Select the job and from the File menu, select Abort.
Select the job, then click on the Abort button in the toolbar.
Right-click the job, then select Abort from the context menu.

5.5.5. Deleting Jobs
To delete a job, do one of the following:
Select the job and press the Delete or Backspace key on your keyboard.
Select the job and from the Edit menu, select Delete.
Select the job, then click on the Delete button in the toolbar.
Right-click the job, then select Delete from the context menu.
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CHAPTER
6
Contour Cutting Using Cutting
Master
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6.1. Adding Registration Marks Automatically
If no object is selected, Cutting Master will automatically add registration marks around your design.
To add registration marks to your design:
Open your job in the design application.
Access the Registration Marks dialog using one of the following methods:
In Adobe Illustrator, from the File menu, select Cutting Master 4 then Registration marks.
In CorelDRAW, select Registration Marks from the Corel Application Launcher. The Corel Application
Launcher is a list in the standard toolbar that lets you launch other applications from within CorelDRAW.

Select the desired registration mark from the topmost list.
Set the necessary parameters and click OK
The following parameters can be set :
Units

The unit of measurement.

Margin

The distance between the registration marks and the job.

Thickness

The thickness of the line that makes up the registration marks.

Length

The size of the registration marks, measured along one side.
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X Step

This option is only available when Segment Area Registration Marks are selected. This controls the distance from one segment mark to the next.

X Direction

Set which side of the page will be considered the X access. This will affect
where the barcode will be added.

Convert Rectangle

If checked, the registration marks will be placed around the border of the selected rectangle. The rectangle will then be deleted, leaving only the registration
marks.

Relative to Page

Relative to Page creates the Registration Marks relative to the edge of a
page,instead of to objects.

Align document origin with If checked, left bottom point of the registration marks becomes (0,0) point of
Registration Marks
ruler of Illustrator or CorelDRAW. If add the registration marks without check
this check box, move the (0,0) point of ruler to left bottom point of the registration marks before send the job to cutter.
Use Reversed Color Registration Marks

If checked, the registration marks will be white with a black square around
them.
Margin

Specify the margin for the square around the registration
mark

Size

Displays the final size of the reversed color registration mark

Use Barcode

Enable Barcode. This prints a barcode along with the registration marks

Barcode Length

Choose the length of the barcode.

Keep Registration Marks

Arrange the barcode without change the spacing and shape of the registration
marks.

Note

Add text to be printed with the barcode. The maximum length is 35 ASCII characters

Barcode Link Info

Displays the barcode link info. This is the number that is recognized by the cutter when cutting the page

Use Trim Marks for the
Registration Marks

Check this option if you are using pattern3 registration marks, which are either
Japanese orRoman style. Trim marks have to be added manually.

Scan Mode

Select the inclination adjustment that has been set on the cutter

Spacing

Specify the distance betweem registration marks.

X Reg Marks Distance

Specify the distance between the registration marks in the X direction

Y Reg Marks Distance

Specify the distance between the registration marks in the Y direction
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6.2. Contour Cutting
Cutting Master allows you to use a cutter to cut a contour on printed output generated on a separate printer.
This produces output similar to that of a hybrid printer/cutter device.
In order to cut a contour on a printed job, you need to do the following:
Create the design for the job in your design application.
Add registration marks that will allow Cutting Master to align the cut contour with the printed job.
Output the printed parts of your design.
Load the printed media into your cutter.
Output the contour part of your design on your cutter.
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6.3. Cutting the Job
To output the contour cut part of your design:
Hide the layer or layers that contain the printed part of your design.
Make sure the layer or layers that contain the contour cuts are visible.
Use the Cut/Plot dialog to send the output to Cutting Master.
Send the cut job to the cutter from Cutting Master, if necessary.
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6.4. Designing a Job for Contour Cutting
When designing a job for contour cutting, the most important thing is that you should be able to separate the
printed parts of the job from the cut parts of the job.
This can be done in two ways:
By placing printed and cut elements on separate layers and then hiding the layers you do not want to output.
By manually selecting the elements you want to print or cut, and then printing or cutting only the selected elements.
Of these two methods, we recommend using separate layers to isolate printed and cut elements, as this works
much better with complex designs.

6.4.1. Adding Registration Marks
The Cutting Master plug-in allows you to add registration marks to your design. These registration marks can
then be used to align a contour cut with the printed output.
The registration marks are added in their own separate, locked layer of the design.

Do not change the name assigned to the layer containing the registration marks.

The registration marks must be printed out in order to be used for automatic alignment of a contour cut. The
marks themselves will not be contour cut.
There are two ways to add registration marks to a design:
Adding registration marks automatically.
Adding a rectangle to the design and replacing it with registration marks.
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If the design is changed or resized after the registration marks are added, you will need to remove the registration marks and add them again in order to properly indicate the new size of the job. Registration marks do
not automatically update when a job is edited or resized.
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6.5. Loading the Printed Media into Your Cutter
Once the printed parts of the job have been output, allow the ink to dry (if necessary), then remove the media
from the printer and load it into your cutter.
Be sure to orient the printed media so that the registration marks are not upside down, as this can cause problems.`

On a Flatbed type of cutter

On a roll cutter
Load the media into the cutter then position the head over the registration mark located at the bottom right
corner when facing the cutter.
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6.6. Printing the Job
To output the printed parts of the design:
Hide the layer or layers which contain the contour cuts.
Make sure the layer or layers which contain the printed part of the design are visible.
Use the standard printing function of the design application to send the job to your printer.
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6.7. Removing Registration Marks
To remove the registration marks, do one of the following:
Repeat the procedure used to add the marks, but select None.
Unlock and delete the layer that contains the registration marks.
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6.8. Replacing a Rectangle with Registration Marks
If a rectangle is created in the design application, and is selected when the Registration Marks dialog is
opened, Cutting Master 4 can use it as a bounding box for the registration marks. The registration marks will be
placed on the border of the rectangle, and then the rectangle will be deleted, leaving only the registration
marks.

To replace a rectangle with registration marks:
Open your job in the design application.
Draw the rectangle that you want to use as a bounding box.
Access the Registration Marks dialog (see previous instructions).
Make sure the Convert Rectangle option is checked.
Set any other desired options (see previous instructions).
Click OK.
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